NGA GRID GUIDE
HOW TO USE ArcGIS 8.x ANS 9.x TO GENERATE MGRS AND OTHER MAP GRIDS

INTRODUCTION.  The purpose of this guide is to help NGA cartographers and analysts who use ESRI’s ArcMap to create grid and graticule reference systems for their hardcopy operational, reference and planning graphics.

DATA VIEW VS LAYOUT VIEW.  In ArcGIS, grids, graticules, and MGRS grids are normally created in the layout view.  These grids are annotations, not GIS layers, so they are not visible in the data view.

If you wish to view grids and graticules in the data view, they must be in shapefile format.  Procedures for generating grids and graticules in shapefile format are described in a separate guide.  CSAT can create custom-generated graticule- and grid-shapefiles upon request.  Call 314-263-4171 for requests.  In addition, CSAT has numerous graticules and UTM / MGRS grids in shapefile format, which are downloadable from their website:

(WWW) http://earth-info.nga.mil/GandG/coordsys/gislayers/gislayers.htm
(OSIS) http://osis.nga.mil/GandG/coordsys/gislayers/gislayers.htm
(SIPRNET) http://sps.stl.nga.smil.mil/products/gandg/csat2/gislayers.htm
(JWICS) http://jws.stl.nga.ic.gov/products/gandg/csat2/gislayers.htm

PROJECTED VS “UNPROJECTED”

It is important to know the difference between projected and “unprojected” GIS data.

- “Unprojected” is also known as lat/long.
- “Unprojected” means the GIS is set to a geographic coordinate system (GCS) rather than a projected coordinate system.  This is set in Data Frame Properties, Coordinate System tab.  A common example of an unprojected system is “GCS_WGS_84”.
- In an unprojected GCS, the GIS map units are degrees, not meters.  A unit of latitude will equal a unit of longitude, and parallels and meridians will form straight, perpendicular lines.  This is NOT an accurate depiction of the earth, except at the equator.  It’s unprofessional to create a map that is not in a map projection.  For information on specific map projections, see the Quick-Start Guide to ArcGIS Map Projections at the end of this guide.
GRATICULES AND GRIDS

There is some confusion with reference to the terms “graticule” and “grid”.

- **Grid** refers to lines representing X or Y values of a two-dimensional rectangular coordinate system, and uses linear units of measure, usually meters. The coordinate system is based on a map projection. X and Y values are also referred to as eastings and northings.
  - As long as the grid line spacing is the same for both vertical and horizontal lines, the lines of a grid should form perfect squares.
- **Graticule** refers to parallels and meridians, i.e. lines of latitude and longitude, and uses angular units of measure, usually degrees (degrees/minutes/seconds or decimal degrees).
  - When the map is projected, the lines of the graticule should NOT form perfect squares as a grid does, except near the equator.

CREATING GRATICULES AND GRIDS IN ArcGIS

In ArcGIS, grids and graticules are generated and modified in Data Frame Properties, Grids tab. This displays a text window and five buttons.

- The **text window** displays a list of the ArcMap document’s grids and graticules, each with a checkbox next to it. (In a new document, the text window will be empty until a grid or graticule is created).
  - Click inside the checkbox to turn on/off display of the grid in the layout view.
  - When a grid or graticule is created, it is then added to the text window. To change the name, click once on the name to activate it. Click a second time (not a “double-click”) to enable name change.
- The **New Grid** button is for creating a new grid or graticule. Clicking on it should bring up the Grids and Graticules Wizard (see Grids and Graticules Wizard below).
- The **Remove** button is for removing a grid or graticule from your ArcMap document. To do so, click on the grid name in the text window to highlight it, then click “Remove”.
- The **Style** button brings up the Reference System Selector window so that the grid style can be changed. When you generate a measured grid in the Grids and Graticules Wizard, you can use this to change it to an MGRS grid (see the “MGRS Grid Generation in ArcGIS” section below).
- The **Properties** button brings up the Reference System Properties window to change the properties of a grid (see “Reference System Properties Tabs” below).
- The **Convert To Graphics** button makes a likeness of a grid in the form of a graphic element. It can then be enlarged, reduced or moved like text or drawings, and is not tied to the coordinate system parameters as is the grid itself (rarely used).
THE GRIDS AND GRATICULES WIZARD

- If clicking on the New Grid button does not bring up the Grids and Graticules Wizard but instead brings up the Reference System Selector window, then ArcMap is not configured to show wizards.
  - To enable wizards, cancel the Reference System Selector window, then click on Tools > Options. Select the Application tab. Check the box next to “Show Wizards when available”. Click OK.
- With GIS configured to show wizards, click “New Grid”. The Grids and Graticules Wizard will appear. It has four windows. The “Next” and “Back” buttons allow you to move from one window to the next.
- In the first window, select either “Graticule” or “Measured Grid”. Change grid name, if desired. Click Next.
- The second window allows you to select desired “appearance” and grid/graticule line interval.
  - If you are creating a grid instead of a graticule, the wizard will include an option for selecting the Coordinate System. You will most likely want to leave the default selection “Same as data frame” (for more info on this, see Reference System Properties, System tab). Click Next.
- The third window allows you to specify properties of neatline ticks and labels. Click Next.
- The fourth and last window allows you to specify properties of the graticule border and neatline. You may also choose to make the grid a “static graphic” (see description of “Convert to Graphics” button). This option is rarely used. Keep the default selection “fixed grid”.
- Click Finish. The graticule/grid name appears in the text window of the Data Frame Properties window.

NOTE: TO AVOID SOFTWARE GLITCHES, YOU MAY BE BETTER OFF TO SIMPLY LEAVE DEFAULT SETTINGS FOR THE LAST THREE WINDOWS, CLICK FINISH, AND THEN GO DIRECTLY TO REFERENCE SYSTEM PROPERTIES.
  - The only critical wizard selection is the first one, choosing a graticule or measured grid.
  - Because the wizard is limited in grid property options, you will almost always end up going immediately to Reference System Properties when you are done with the wizard anyway.
  - If you do choose to utilize the wizard, keep in mind that whatever options you select can be changed later in the Reference System Properties window.
THE REFERENCE SYSTEM PROPERTIES WINDOW

When you click the Properties button, the Reference System Properties window will appear, with several tabs. It has six tabs for graticules, five for grids. Following are the functions for each of the tabs.

Graticules

- **Axes** tab controls graticule features along the perimeter (neatline) of the map.
  - “Border” controls the width, color, etc. of the border (neatline).
  - If the “major division ticks” boxes are checked, tick marks will occur where the graticule lines intersect the border (“major division ticks” are usually not needed).
  - Subdivision ticks are often useful. If subdivision ticks are desired, set spacing by specifying the number of subdivisions. For example, for ticks to occur every degree of latitude/longitude on a map with graticule spacing (see Interval tab) at five degrees, specify 5 subdivisions.
- **Interior Labels** tab enables labeling of graticule lines in the interior of the chart, not just along the perimeter.
- **Labels** tab controls activation of labels along perimeter of map, as well as font, size, color, and orientation.
  - If you have several grids, you may wish to increase “Label Offset” to avoid overlapping labels of another grid.
  - The “Additional Properties” button allows labels to display only degrees, instead of DMS (e.g., 45° N instead of 45° 0’ 0” N). Direction labels can also be removed.
- **Lines** tab controls whether the graticule will be displayed as lines (parallels and meridians) or ticks (“crosshairs”, where parallels and meridians intersect). Also controls thickness, color, etc. of the lines/ticks.
- **Hatching** tab. Hatch marks are like “ticks”, but occur along graticule lines instead of the map border. To generate hatch marks, specify a hatch interval. (The Hatching tab also allows axis ticks along the map border to be “offset”, or placed away from, the map border. This function is rarely used.)
- **Intervals** tab. Controls spacing of graticule lines, and sets origin. For example, to generate graticule lines spaced five degrees apart, enter X Axis Interval=5, Y Axis Interval=5.
  - IMPORTANT: FOR “SET ORIGIN”, ALWAYS SELECT “DEFINE YOUR OWN ORIGIN”, AND SET X-ORIGIN=0, Y-ORIGIN=0.

Grids

- **Axes** tab. Same as for graticules.
- **Labels** tab. Same as for graticules, except for the following: There are three grid label style formats: Mixed Font, Corner Label, and Formatted. Also, the “Additional Properties” button has different controls for grids than for graticules. That’s because
(except for rare cases) graticule labels are in degrees (or DMS), and grid labels are in meters.

- It is highly recommended that label style format “Formatted” be selected. Click “Additional Properties” button. For number of decimal places, enter 0. You may also wish to activate “show thousands separators” if grid lines are spaced at 10,000m or more.
- The default grid label style format is “Mixed Font”, which shows large-value digits in a large black font, and small-value digits in a small red font. “Mixed Font” is very difficult to control and is best avoided.
- The “Corner Label” style is also extremely difficult to use and is best avoided. If corner labels were needed, it would be better to create them manually, using the “New Text” icon. Actual corner coordinate values can be determined by placing the pointer icon on the map corner and reading the coordinate display in the lower-right corner of the screen.

- **Lines** tab. Same as for graticules.
- **System** tab. In most cases, select “current coordinate system”. If you want the grid to be based on a map projection other than the one on which the data frame (your map) is based, select “use another coordinate system”.
- **Intervals** tab. Same as for graticules. Note that units will be in meters instead of degrees. Change “Axis Intervals” to an appropriate round number, such as 1000, 10,000, or 100,000, depending on map scale. The following table is a rough guide for spacing:

<table>
<thead>
<tr>
<th>APPROXIMATE SCALE</th>
<th>EQUIVALENT NGA MAP</th>
<th>GRID LINE SPACING</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:25,000 TO 1:100,000</td>
<td>TLM</td>
<td>1,000</td>
</tr>
<tr>
<td>1:250,000</td>
<td>JOG</td>
<td>10,000</td>
</tr>
<tr>
<td>1:500,000 TO 1:1,000,000</td>
<td>TPC, ONC</td>
<td>100,000</td>
</tr>
</tbody>
</table>

- In most cases, you will leave “Units” in meters. Simply changing the interval value to another unit, such as feet, would rarely be useful. The resulting grid lines would be spaced in increments of feet, but they would still be labeled in meters. Additional steps are involved in order to generate a grid using different units, such as feet, and still have the grid lines labeled in those units. First, go to the System tab. Choose “Use Another Coordinate System”. Select the same map projection that your data frame is in, but click “Modify”. Change “Linear Units” to feet. Click OK, click OK. Go back to Intervals tab, and change units to Unknown Units.
- IMPORTANT. As with graticules, CHOOSE “DEFINE YOUR OWN ORIGIN, AND SET X-ORIGIN=0, Y-ORIGIN=0.

**MGRS GRID GENERATION IN ArcGIS**

MGRS grids can be generated using the standard grid generation procedure described above, but ArcMap has provided an MGRS template to make it much easier. Following is the procedure for utilizing the MGRS grid generation template.
NOTE: Before generating an MGRS grid, you must change your coordinate system to UTM. Follow these steps to do so:

- Click View > Data Frame Properties.
- Choose “Coordinate System” tab.
- To select a UTM coordinate system, browse in the “Select a coordinate system” window to the following: Predefined / Projected Coordinate Systems / Utm / Wgs 84 / WGS 1984 UTM Zone XXN, where XX is the UTM zone of your area of interest.

With coordinate system set to one of the UTM zones, you are ready to create an MGRS grid.

The following is taken directly from ESRI Help, under “Grids, MGRS” (with a few independent comments added in italics). Follow these steps to create an MGRS grid in the layout window.

Adding an MGRS Grid to your list of personal styles

1. Click the Tools menu, point to Styles, then click Style Manager.
2. In the Styles tree view to the left, click the name of the style file into which you would like to add an MGRS Grid style. Comment: It doesn’t seem to matter which style file you choose.
3. In the style folders on the right, right-click Reference Systems. Choose New and choose MGRS Grid.
4. Click OK to close the Reference Systems dialog box. And don’t select any of the options in any of the tabs—-that will be done later.
5. Click Close.

Creating an MGRS Grid

1. Click the View menu and click Data Frame Properties.
2. Click the Coordinate System tab and make sure the data frame is set to a UTM projected coordinate system.
3. Click the Grids tab.
4. Click New Grid.
5. From the list of grids, choose the MGRS Grid that you added into your list of personal styles (see the previous procedure, ‘Adding an MGRS Grid to your list of personal styles’).
6. On the MGRS tab, select options for enabling/disabling ladder labels and 100,000-meter grid zones. If your map scale is 1:1,000,000 or smaller, you can also specify interior tick marks that fall along the grid lines.
7. The Labels tab allows you to specify labeling options for the axis labels. The font style, size, and color affect the principal digits. Click Additional Properties to specify the font style and size of the secondary (base) digits. The Corner Labels tab allows you to choose which corners of the map will be labeled with full coordinate values.

**NOTE**: For MGRS grids, you do not select grid line spacing interval. ArcMap will determine line spacing automatically.
QUALITY ASSURANCE FOR GRIDS

Analysts can assure correct grid generation by checking to make sure that the grid and its coordinates are in proper position with respect to the map projection/coordinate system upon which it is based. Here are some map projection basics:

- All map projections have an origin. The origin is where the map projection’s central meridian crosses its latitude of origin.
- The map projection origin is also the origin of the grid.
- Grid coordinate values, which are almost always in meters (occasionally feet or yards), represent actual ground distance from the origin. Grid distances correspond exactly to distances on the map scale.
  - Note: Grid coordinate values and map scale distances will not be exact ground distance due to distortion (every map projection distorts the earth in some manner). However, if the coordinates are within the intended map use zone of a conformal projection (UTM, Lambert Conformal Conic, etc.), grid coordinates will correlate very closely to actual ground distance.
In the above map, the graticule lines are red, and the grid lines are gray.

- Grid values (eastings and northings) are in meters, and are labeled around the perimeter of the map. Note how grid values occur in relation to the map projection origin.
- Note how the central meridian coincides with the Y-axis of the grid. This is true for virtually all map projections.

In a conic projection such as this one, the latitude of origin is an arc, not a straight line, so it does not correspond to the X-axis of the grid. However, in a cylindrical projection (UTM, Mercator, etc.), the latitude of origin does correspond to the X-axis of the grid.

- Many map projections apply a **false easting** and/or **false northing**. Their purpose is to avoid negative grid coordinates, which can cause confusion.
  - The map below is a modification of the previous map. It now has a false easting of nine million and a false northing of three million. Without a false easting and false northing, most of the map would have negative grid coordinate values.
One important way to check grid coordinate values in a GIS is to read the **coordinate display**, which displays the coordinates of the mouse pointer position. In the figure below, the magenta arrow represents the position of the mouse pointer, which is very close to the grid corner at 3000000mE, 3000000mN. Below the layout view of the GIS (bottom-right magenta circle) is the coordinate display, providing the exact values of easting and northing for the position of the mouse pointer. The display may be changed from meters to degrees in Data Frame Properties.
QUALITY ASSURANCE FOR MILITARY GRIDS

Apply map projection basics to assure correct military grid generation:

- **UTM grids** are based on the Transverse Mercator map projection.
  - The latitude of origin is 0° (the equator).
  - The central meridian runs through the center of the UTM zone.
  - The false easting is 500,000.

In the map below, UTM Zone 38 lies between 42° and 48° E. The central meridian is 45° E.
- **MGRS grid** lines coincide exactly with UTM grid lines. In MGRS, the 100,000-meter grid squares are assigned a two-letter designator (see map below).

**FOLLOWING ARE SOME EXTRA ILLUSTRATIONS:**
THIS IS AN ENLARGEMENT OF THE PREVIOUS MGRS MAP, TO ILLUSTRATE HOW ARCMAP ADJUSTS THE GRID LINE SPACING. SCALE WAS INCREASED, SO SPACING WENT FROM 100,000 METERS TO 10,000 METERS. THE GIS ANALYST ADJUSTED THE PROPERTIES OF THE GRID SQUARE DESIGNATORS SO THAT THEY ARE SMALLER, AND APPEAR AT THE CORNERS INSTEAD OF THE CENTER. NOTE UTM VALUES IN MARGINS. ALSO, “LADDER” VALUES WERE ADDED.
SAME MGRS MAP WAS ENLARGED SOME MORE. NOW, GRID LINES HAVE GONE FROM 10,000 METERS TO 1,000 METERS.
THIS ILLUSTRATES DEFAULT LABELING ALONG NEATLINE (AXES) OF MAP: “MIXED FONT”. SEE ENLARGEMENT BELOW.
ENLARGEMENT OF DEFAULT “MIXED FONT” LABELING STYLE
HERE, LABEL STYLE WAS CHANGED TO “FORMATTED”. ALSO, THE DECIMALS WERE REMOVED BY UTILIZING THE “ADDITIONAL PROPERTIES” BUTTON.
ENLARGEMENT SHOWING NEW “FORMATTED” LABEL STYLE, DECIMALS REMOVED.
THIS ILLUSTRATES THE AXES FEATURES THAT THE AXES TAB CONTROLS.
ENLARGEMENT OF AXES FEATURES

AXES FEATURES

MAJOR TICK
SUBDIVISION TICK
BORDER
THIS ILLUSTRATES VARIOUS FEATURES WHOSE PROPERTIES ARE CONTROLLED BY VARIOUS REFERENCE SYSTEM PROPERTIES TABS
ENLARGEMENT OF VARIOUS FEATURES FROM REFERENCE SYSTEM PROPERTIES

- Graticule lines, spaced every 5º, see "Lines" and "Intervals" tabs.
- Hatch marks, interval 3º, see "Hatching" tab.
- Subdivision ticks, 5 subdivisions, see "Axes" tab.
- Labels along bottom axis, see "Labels" tab.
  ("Additional properties" button was used to show only degrees instead of DMS.)
THIS ILLUSTRATES INTERIOR GRID LABELS. NOTE: THE “GRID” IN THIS CASE IS NOT A “MEASURED GRID”, BUT A GRATICULE.
HERE IS AN EXAMPLE OF A LAYOUT WINDOW WITH TWO GRIDS, EACH ONE FROM A DIFFERENT COORDINATE SYSTEM. THE BLACK IS FOR THE DATA FRAME'S COORDINATE SYSTEM, UTM ZONE 38. THE RED IS FOR UTM ZONE 39.
ENLARGEMENT OF TWO-GRID EXAMPLE. NOTE VALUES FOR NORTINGS AND EASTINGS ALONG AXES.
HATCHING EXAMPLE

HATCHING IS SHOWN IN RED, AT 30' SPACING, LENGTH 20 POINTS.
QUICK-START GUIDE TO ArcGIS™ MAP PROJECTIONS

This guide is intended for the generation of custom products such as reference maps, planning maps, graphics that accompany geospatial studies, and digital GIS products. It should NOT be used as guidance for NGA standard products or any other product used in navigation or targeting.

WHEN CREATING MAPS, GIS DATA SHOULD NEVER BE LEFT IN THE DEFAULT "UNPROJECTED" COORDINATE SYSTEM. ALWAYS SELECT AN APPROPRIATE MAP PROJECTION FOR DISPLAYING GEOSPATIAL DATA AND REFERENCE MAPS.

With the exception of maritime and polar charts, NGA maps and charts mainly use the Lambert Conformal Conic (LCC) and Transverse Mercator (TM) projections. Therefore, as a general rule of thumb, use TM (or UTM) for large-scale (small area) maps, and LCC for small-scale (large-area) maps.

FOLLOWING IS A BRIEF GUIDE TO ArcGIS™ MAP PROJECTIONS.
First, select "Projected Coordinate Systems". "Geographic Coordinate Systems" do not contain map projections, but are used to process GIS data that are in a local datum.

Select one of the following Projected Coordinate System categories according to your Area of Interest and mapping need:

- "Continental" contains conic projections.
  - Lambert Conformal Conic, or "LCC", is a good conformal projection for areas in mid-latitudes. Distortion is minimized along east-west standard parallels. It’s good for displaying large multi-national regions and continents. TPCs and ONCs use LCC.
  - Albers Equal Area. Areas on map are proportional to areas on earth.

The remainder of this guide will provide some brief definitions for each of the above categories.
- **Equidistant.** Distances are true along meridians and standard parallels.

To suit your area of interest, you may want to modify the map projection parameters: **Standard Parallels 1 & 2**, and **Central Meridian**.

- Scale and distance are "true" along the standard parallels.
- The Central Meridian is the one meridian on the map where north is "straight up".

"CONTINENTAL" MENU DISPLAYS:

- "Gauss Kruger", or "GK", is very similar to UTM. Some countries use GK instead of UTM for their grid system. This would be used when dealing with coordinates of a grid system that uses the GK.

- "National Grids" are grid systems for individual countries, each based on a map projection. As with GK, use this when working with coordinates of a particular country’s grid system.

- "Polar" contains planar, a.k.a. azimuthal, projections. These types of projections are needed to map polar areas, BUT, for some purposes, they are ALSO useful in non-polar areas.

For non-polar uses, modify the map projection parameters: **Central Meridian** and **Latitude of Origin**.

- **Azimuthal Equidistant.** All distances from the origin point of the projection are true.
- **Gnomonic.** All great circles on the globe are straight lines on the map.
- **Lambert Azimuthal Equal Area.** Areas of polygons are true.
- **Orthographic.** Useful for displaying the world as a globe.
- **Stereographic.** Used in geophysics and other applications.
- **UPS.** Universal Polar Stereographic system, the polar segment of the UTM/MGRS system.

"Polar" menu display:

- "State Plane" contains individual state grid systems in the U.S. Used by surveyors, engineers, city governments, etc.
- "UTM" contains all 60 UTM/MGRS zones, each based on the Transverse Mercator Projection.
  - **NOTE:** USE "UTM" FOR ANY TRANSVERSE MERCATOR PROJECTION, whether part of the UTM system or not (if not, parameters will be modified).
  - Transverse Mercator is a good conformal projection for areas that stretch in a north-south direction. Distortion is minimized along the central meridian.

"UTM" menu displays:
"World" contains various projections that are useful for displaying a world map. Some (e.g. Mercator) are also useful for displaying equatorial regions.

REFERENCES: